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S
e state seguendo questa
serie dall' inizio adesso
dovreste essere del tutto a
vostro agio con ellissi,

rettangoli e stelle. Dovreste essere
in grado di costruire dei tracciati
piuttosto complessi usando le
operazioni Booleane, poi
manipolarle con lo strumento Nodi.
Sapete dare colori, gradienti e temi
ai vostri oggetti, come anche
applicare delimitatori, spessori e
margini diversi ai loro contorni. In
breve avete un insieme di
strumenti sufficiente a creare
disegni piuttosto complessi, se
vorrete. In questa puntata
esamineremo i modi di gestire
questa complessità.

Mentre in un disegno aumenta la
quantità degli oggetti, diventa
sempre meno probabile che sia
accettabile il manipolarli uno alla
volta. Se volete scalare o ruotare il
cappello del nostro pupazzo di neve,
per esempio, ben presto diverrete
frustrati se dovete prima manipolare
il bordo, poi il lato, dopo la cima; e
questo senza considerare le ombre e
i riflessi che abbiamo aggiunto
l'ultima volta. Un approccio di gran
lunga migliore è selezionare tutte le

parti ed eseguire le vostre operazioni
su di loro simultaneamente.

La volta scorsa avete imparato
come selezionare due oggetti alla
volta tenendo premuto MAIUSC
mentre fate clic sul secondo. Se
continuate a premere MAIUSC
mentre fate clic su altri oggetti,
ciascuno sarà aggiunto alla selezione.
Premendolo mentre fare clic su un
oggetto già selezionato lo rimuoverà
dalla selezione. Questo approccio è
utile quando volete selezionare solo
alcuni oggetti o se essi sono
considerevolmente distanziati con
altri oggetti in mezzo.

Nel caso del nostro cappello,
comunque, vi è un modo molto
migliore. Gli oggetti sono
raggruppati insieme strettamente il
che rende facile trascinare
semplicemente attorno a loro una
casella di selezione come segue: fate
clic e tenete premuto su un'area
vuota della tela, poi trascinate il
mouse in diagonale lontano dal
punto di inizio. Vedrete un
rettangolo, la casella di selezione,
che segue il puntatore del mouse.
Quando rilasciate il pulsante,

qualunque cosa dentro il rettangolo
sarà selezionata.

Sfortunatamente sulla tela non
c'è sempre un'area vuota nelle
vicinanze. Nel caso del nostro
cappello se è sul posto sopra il
pupazzo di neve allora avrete
probabilmente fra i piedi il
rettangolo di sfondo. Se cercate di
trascinare una casella di selezione
iniziando su un altro oggetto finirete
invece per spostare quell'altro
oggetto. La risposta è tenere
premuto MAIUSC mentre iniziate a
trascinare il mouse, il che eviterà ad
Inkscape di selezionare l'oggetto su
cui avete iniziato. Ricordate
MAIUSC+clic aggiungerà alla vostra
selezione (o rimuoverà da essa) ma
MAIUSC+trascinamento eviterà che
sia aggiunto l'oggetto su cui si è fatto
clic.

Con una casella di selezione, una
limitazione è che essa selezionerà

soltanto oggetti che sono inclusi
interamente dentro la casella. Ciò
può essere un problema se avete
fatto uno zoom proprio dentro, o i
vostri oggetti sono troppo vicini e
volete selezionare solo alcuni di loro.
In questi casi potete usare la
modalità di Inkscape 'seleziona col
tocco': tenete premuto il tasto ALT
mentre fate clic e trascinate intorno
il mouse, disegnando una linea rossa
mentre procedete. Quando rilasciate
il pulsante del mouse qualunque
oggetto che sarà toccato dalla linea

rossa verrà selezionato. Se volete
aggiungere alla selezione esistente,
tenete premuto anche MAIUSC.

Su molti sistemi Linux scoprirete
rapidamente un problemino se
cercate di usare ALT-trascinamento
per la modalità selezione col tocco:
spesso i gestori di finestre usano
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ALT-trascinamento come modo per
spostare in giro la finestra senza
dover trascinare la barra del titolo,
il che evita che ALT-trascinamento
funzioni in Inkscape. Vi sono tre
modi di occuparsi questa
limitazione:
• Disabilitare l'opzione ALT-
trascinamento nelle preferenze del
vostro gestore di finestre. Ciò non è
sempre facile da fare e di solito
avrà l'effetto collaterale di
disabilitarlo per tutte le finestre da
tutte le applicazioni, non solo da
Inkscape.
• Tenere premuto il tasto SUPER
(così viene teoricamente chiamato
nel mondo Linux ma probabilmente
lo conoscete meglio come tasto
WINDOWS) in aggiunta a ALT o
MAIUSC-ALT.
• Iniziare a trascinare o MAIUSC-
trascinamento mentre state
trascinando una casella di
selezione, poi premere ALT per
cambiare alla modalità selezione
col tocco durante il processo.
Potete premere e rilasciare ALT
tanto spesso quanto volete durante
questo processo; è soltanto quando
il pulsante del mouse viene
rilasciato che Inkscape controllerà
per determinare se usare la casella
di selezione o la modalità selezione
col tocco.

Con parecchi oggetti selezionati,
è il momento di combinarli in un
'gruppo' usando l'icona della barra
degli strumenti, la scorciatoia CTRL-G
o selezionando la voce del menù
Object>Group. Adesso potete
spostare, scalare, deformare e
ruotare tutti gli oggetti come se
fossero un singolo oggetto. Questo
rende facile combinare le forme
separate che fanno una singola
entità, come il cappello del nostro
pupazzo di neve. Potete anche creare
un gruppo che contenga un solo
oggetto ma di solito il
raggruppamento viene utilizzato per
rendere più facile lavorare con

parecchi oggetti che
formano una singola parte
della vostra immagine.

Spesso vorrete modificare un
oggetto che è nel vostro gruppo. Un
approccio è selezionare il gruppo, poi
usare Object>Ungroup (CTRL-MAISC-
G) o il pulsante Ungroup sulla barra
degli strumenti (mostrato a sinistra)
per scomporre il gruppo nelle sue
parti costituenti. Dopo aver
modificato il vostro oggetto potete
raggrupparli di nuovo. Di solito è
vantaggioso modificare un oggetto
senza la trafila di dividere e poi
riunire dopo, così Inkscape vi
permette di 'influenzare' un gruppo
per lavorare direttamente coi suoi

contenuti. Il modo più veloce di
influenzare un gruppo è
semplicemente fare doppio clic su di
esso, sebbene vi sia un'opzione in
fondo al menù contestuale del tasto
destro per 'Enter Group g#20'.
Inkscape assegna un identificatore
unico a un gruppo, così questa voce
di menù sarà leggermente diversa
per ciascuno di loro.

Una volta che avete influenzato
un gruppo sarete liberi di modificare
individualmente i suoi contenuti. La
barra di stato vi mostrerà quando
siete dentro un gruppo piazzando
temporaneamente il suo ID nel pop-
up dei livelli, a destra delle
impostazioni riempimento contorno
e opacità (mostrati sopra).

Avendo inserito un gruppo,
qualunque oggetto che incolliate
dagli appunti sarà aggiunto ai
contenuti di quel gruppo, come lo
sarà qualunque nuovo oggetto
creiate. Vi sono vari modi di uscire da
un gruppo ma il più comune è
semplicemente selezionare un
oggetto che sia all'esterno del
gruppo. Potete anche fare doppio
clic su un'area vuota della tela se non
volete selezionare qualcos'altro o

selezionare 'Go to Parent' dal menù
contestuale.

In aggiunta a spostare e
trasformare un gruppo, potete anche
aggiustare le sue impostazioni
riempimento e contorno. Impostare
riempimento e contorno applicherà
questi valori ad ogni oggetto nel
gruppo, come lo farà un
cambiamento alla larghezza del
contorno. Sfortunatamente nessuno
degli altri attributi di stile della linea
può essere sistemato così, quindi se
volete che tutti gli oggetti nel vostro
gruppo abbiano un contorno
tratteggiato avrete bisogno di
influenzare il gruppo e di sistemare
ciascuno individualmente.

Impostare un colore uniforme per
il riempimento e contorno di un
gruppo fa esattamente ciò che
potreste aspettarvi. Ma provate a
impostare un gradiente o un motivo
per l'intero gruppo e potreste
rimanere un po' sorpresi del risultato.
Supponete di volere applicare un
gradiente dal bianco al nero lungo
una quantità di oggetti: potreste
essere tentati di raggrupparli e poi
applicare il gradiente al gruppo.
Questo è l'effettivo risultato che



full circle magazine #68 24 indice ^

HOWTO - INKSCAPE Parte 8
otterreste:

Come potete vedere, sebbene i
passaggi del gradiente coprano
l'intera larghezza del gruppo.
Inkscape in effetti ha usato solo una
piccola porzione di esso, la quantità
coperta dal primo oggetto, e poi ha
ripetuto quella piccola quantità per
ogni altro oggetto nel gruppo. Così
invece di bianco al nero attraverso
quattro oggetti, otteniamo bianco al
grigio attraverso un oggetto, che
quindi viene utilizzato anche per gli
altri tre. Lo stesso problema si
applica ai motivi: ciascun oggetto ha
applicata una copia del motivo del
primo, piuttosto che vi sia un motivo
che copre l'intero gruppo. Vi è una
risposta a entrambe questi problemi
in forma del fissaggio ma è un
argomento più complesso, da

trattare in un altro giorno.

La sezione in basso della finestra
'Fill and Stroke' ha un effetto a livello
di gruppo. Se impostate l'opacità o la
sfocatura per un gruppo, essa si
applica all'intero gruppo come un
oggetto singolo. Questo in aggiunta
ad qualunque opacità o sfocatura che
sia stata applicata agli oggetti
individuali, il che vi consente di creare
complesse combinazioni di effetti. In
questa immagine la fila in cima
mostra due gruppi, uno con nessuna
opacità sui suoi oggetti e uno con il
cerchio verde impostato a 50% di
opacità. La fila sotto mostra cosa
accade quando applicate anche una
opacità del 50% al gruppo stesso.

Piuttosto che applicare l'opacità a
ciascun oggetto individuale, come
farebbe un colore uniforme, i cerchi
mantengono le loro opacità
individuali e poi l'opacità del gruppo
viene applicata all'intero. Le stesse
regole si applicano per la sfocatura:
vengono prima sfocati gli oggetti
individuali, poi viene applicata a
livello di gruppo la sfocatura all'intera
raccolta.

Potrebbe sembrare contro
intuitivo l'avere riempimento e
contorno che influenzano i gruppi in
un modo mentre sfocatura e opacità

li influenzano in un modo diverso.
Nella pratica è qualcosa a cui vi
abituate molto velocemente e il
vantaggio artistico di avere livelli
multipli di opacità e sfocatura ha
maggior peso di qualunque
confusione a breve termine.

I gruppi sono impagabili per
raccogliere insieme in una singola
entità di facile gestione oggetti
collegati, com'è il caso del cappello
del pupazzo di neve al principio di
questo articolo. Potrete anche creare
un altro gruppo per la testa del
pupazzo e un terzo per il suo corpo e
le braccia. Muoverlo in giro sul vostro
disegno è adesso molto più semplice
dato che vi sono solo tre oggetti da
selezionare e spostare, piuttosto che
le dozzine che dovevate affrontare in
precedenza. Ma possiamo rendere le
cose ancora più semplici creando un
gruppo che sia fatto dei tre gruppi
esistenti. Selezionateli tutti e tre e
create un gruppo nello stesso modo
in cui abbiamo fatto in precedenza
nell'articolo.

Con un gruppo singolo
contenente tutte le parti del nostro
pupazzo di neve, è banale muoverlo
intorno. Se dovete aggiustare la
posizione o l'angolo del suo
cappello, influenzate il gruppo e
potrete interagire coi tre gruppi

all'interno. Selezionate uno di questi
e potete influenzarlo di nuovo per
scendere fino agli oggetti individuali.
Inkscape vi permette di annidare i
vostri gruppi profondamente quanto
volete.

Per uscire da un gruppo annidato
in profondità, potete usare le stesse
tecniche che per un singolo gruppo.
Per fare un passo indietro di un
livello alla volta dai vostri gruppi
potete fare doppio clic su un area
vuota della tela o utilizzare l'opzione
del menù contestuale 'Go to Parent'.
Per saltare direttamente a un
particolare livello dovete solo fare
clic su un altro oggetto o gruppo che
sia a quel livello. In alternativa potete
usare il pop-up dai livelli sulla barra di
stato per saltare diritti a qualunque
gruppo antenato o anche per
ritornare a livello della pagina.

I gruppi annidati seguono le
stesse regole di qualunque altro
gruppo quando si tratta dei colori di
riempimento e contorno, opacità e
sfocatura. Impostate un colore di
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riempimento su un gruppo annidato
e tutti gli oggetti, non importa
quanto profondamente annidati,
saranno impostati a quel colore ma
l'opacità e la sfocatura vengono
applicati separatamente a ciascun
oggetto e gruppo.

Sebbene i gruppi siano uno
strumento impagabile per gestire
disegni complessi, non sono senza
limiti. In particolare, un gruppo
occupa un singolo 'slot' nello z-order
della pila, così non potete
interfogliare gli oggetti da un gruppo
con quelli da un altro. In questa
immagine ho disegnato una serie di
quadrati intervallati sulla sinistra.
L'immagine a destra mostra il
risultato del combinare in un gruppo
solo i quadrati rossi: l'intero gruppo
prende solo un intero slot nello z-
order occupando lo stesso slot come
l'oggetto in cima nel gruppo.

Se immaginate questi oggetti

come una pila di fogli di carta, è un
po' più ovvio cosa è successo.
L'immagine seguente mostra i fogli
intervallati impilati in cima a ciascun
altro, seguita dalla riorganizzazione
dello z-order una volta che i fogli
rossi vengono raggruppati insieme.

Se selezionate un gruppo potete
modificare lo z-order degli oggetti
ma solo relativamente l'uno all'altro.
Il gruppo come intero prenderà solo
un singolo slot. In questo caso
significa che i tre fogli rossi sono
indivisibili; non potete neanche
spostare tra loro uno dei fogli arancio
senza o dividere i fogli rossi o
spostare anche il foglio arancio
dentro il gruppo. Questa limitazione
vi impedirà di creare dei gruppi che
possano essere utili altrimenti (una
corda che strisci attorno sia al davanti
che al retro di un altro oggetto non
potrebbe essere raggruppata come
oggetto singolo) ma in molti altri casi
i gruppi semplificheranno
significativamente il vostro utilizzo di
Inkscape.

CCOODDEEWWOORRDD
Ogni numero nella griglia è il "codice" di una lettere dell'alfabeto.
Quindi il numero "2" può corrispondere alla lettera "L", per
esempio. Tutti, eccetto i codeword difficili , hanno alcune lettere
per iniziare.

I giochi sono copyright, e gentilmente forniti
da, The Puzzle Club - www.thepuzzleclub.com

Le solutioni sono nella terz'ultima pagina.

http://www.peppertop.com/
http://www.thepuzzleclub.com
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Avendo trattato l'uso dei gruppi in
Inkscape, ci sposteremo adesso

sui 'livelli' – che sono proprio come i
gruppi ma con un'interfaccia diversa
permanipolarli. Vi è una buona ragione
per le similarità tra gruppi e livelli: il
formato SVG non ha un concetto di
livelli così Inkscape, di fatto,
implementa ciascun livello come un
gruppo con alcune parti extra di dati
personalizzati.

Vi sono tre parti dell'interfaccia di
Inkscape che vengono utilizzate per
gestire i livelli: il menù Layer, una sotto

finestra dedicata Layers e alcuni
strumenti ad accesso rapido nella barra
di stato in fondo alla schermata.
Cominciamo con la sotto finestra
Layers che può essere aperta tramite la
voce di menù Layer>Layers, premendo
CTRL-MAIUSC-Lo utilizzando il
pulsante ViewLayers sulla
barra degli strumenti.

La finestra livelli è abbastanza
scarsa, consistendo di un elenco di livelli
in cima e di alcuni pulsanti e altri widget
al fondo. Per un nuovo file sarà
presente solo un singolo livello,
chiamato di solito "Layer 1 ". Create
alcuni oggetti nel vostro disegno ed
essi diverranno parte di quel livello.
Adesso provate a fare clic sulla piccola
icona, l'occhio a sinistra del "Layer 1 " e
vi accorgerete che i vostri oggetti
svaniscono. Fate di nuovo clic su di essa
e riappariranno. Fate clic sull'icona della
catena e vi verrà impedito di fare
qualunque cambiamento agli oggetti
nel livello. Un secondo clic sbloccherà il

livello.

Vi sono parecchi modi di creare un
nuovo livello ma il più ovvio è
semplicemente fare clic sul pulsante
verde + in fondo alla finestra Layers. Vi
sarà suggerito di dare un nome al livello
e di scegliere una posizione peresso.
Per adesso chiamiamo il nostro nuovo
livello "Layer 2" e posizioniamolo sopra
il livello attuale.

La finestra Layers dovrebbe
apparire proprio come vi aspettate, con
due voci: "Layer 2" è in cima all'elenco e
"Layer 1 " è sotto di esso. L'ordine dei
livelli nella finestra rappresenta il loro z-
index all'interno del disegno cosicché i
livelli più in basso nell'elenco
appariranno indietro ai livelli che sono
più in alto nell'elenco. Controllate che
"Layer 2" sia selezionato e disegnate
degli altri oggetti assicurandovi che si
sovrappongano agli oggetti precedenti
del "Layer 1 " e che siano in un colore
adeguatamente contrastante.
Dovreste essere in grado di vedere che
i vostri nuovi oggetti vengono sempre
disegnati sopra i vecchi oggetti.
Utilizzando le icone freccia in fondo alla
finestra Layers potete riordinare i vostri
livelli, il che a sua volta altera lo z-index

degli oggetti nel vostro disegno.
Ricorderete che i contenuti dei gruppi
non possono essere interfogliati, con
ciascun gruppo che occupa un singolo
"slot" nello z-index. La stessa cosa si
applica ai livelli: potete spostarli l'uno
rispetto a un altroma i loro contenuti
non si possonomescolare.

Quando create un nuovo livello
potete usare il pop-up Position per
scegliere se il nuovo livello deve stare
sopra o sotto il livello attuale. Vi è
anche una terza opzione, quella di
renderlo un sub livello dell'attuale
livello. I sub livelli appaiono nella
finestra sotto il loro livello genitore,
leggermente indentati. Il genitore
acquista una piccola icona a triangolo
che può essere usata permostrare o
nascondere l'elenco dei sotto livelli.
Allo stessomodo dei gruppi che
possono essere profondamente
annidati, così è possibile aggiungere
sub livelli ai sub livelli – sebbene andare
a fondo di due o tre livelli è possibile
che, più che aiutare, confonda.
Quest'immaginemostra il nostro
"Layer 1 " con l'aggiunta di tre sub livelli,
due dei quali hanno anche loro dei sub
livelli, uno dei quali è compresso
usando il pulsante a triangolo:
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L'ordine dei sub livelli all'interno
della finestra segue le stesse regole
come per i livelli normali: più in basso è
il sub livello nella finestra, più in basso
saranno nel disegno i suoi contenuti
nello z-index. Da ciò ne segue che il
contenuto di un sub livello apparirà
sempre sotto qualunque contenuto nel
suo livello genitore. Sebbene ciò abbia
un senso logico, spesso non è ciò che
desiderate da un punto di vista
artistico, così trovo che ilmigliore
approccio nell'usare i sub livelli sia
semplicementemantenere vuoto da
oggetti il livello genitore e costruire un
sub livello aggiuntivo sotto gli altri per
tenere qualunque contenuto di sfondo.

Il vantaggio più grosso dei sub livelli
è quello di nascondere subito parecchie
parti di una immagine con rapidità.
Considerando il nostro pupazzo di neve
delle puntate precedenti, potreste
facilmente costruire un livello genitore
per contenere il pupazzo di neve come
un intero, con parecchi sub-livelli per
ciascuna parte del suo corpo. Adesso
avete la capacità di nascondere o
bloccare le sue parti individuali
utilizzando le icone accanto a ciascun

sub livello o di nascondere o bloccare
rapidamente l'intero personaggio
usando le icone permezzo del livello
genitore.

Ricorderete che la puntata
precedente suggeriva di raggruppare
insieme le varie parti del pupazzo di
neve per creare un singolo oggetto che
potetemuovere intorno con facilità.
Allora cosa èmeglio, il raggruppare o
usare i livelli? Come è spesso il caso, la

risposta è “dipende”. Per qualcosa
come il pupazzo di neve tenderei ad
utilizzare i gruppi: la capacità di
spostare l'intero personaggio come una
cosa sola è di solito più utile della
capacità nasconderlo. Per lo sfondo
dell'immagine (la neve, il cielo, le stelle)
probabilmente userei un livello: è
improbabile che spostiate molto lo
sfondoma potreste volerlo
nascondere, quando lavorate sul
pupazzo di neve, o bloccarlo perevitare
che, accidentalmente, venga
modificato una volta che ne siete
contenti.

Guardiamo ad un esempio del
mondo reale (mostrato sotto). Questa
è una striscia di fumetto che ho
disegnato nel 201 0, insieme alla
corrispondente finestra Layers. Potete
scaricare il file sorgente di Inkscape
dall'URL alla fine dell'articolo.

Lavorando dal livello in cima verso il
basso, dapprima abbiamo un livello
Frame che è bloccato. Questo è un
bordo nero spesso che sta come livello
più alto in molti dei miei fumetti e
nasconde le estremità delle linee che si
estendono fuori dall'immagine
principale, cosicché non devo stare così
attento quando disegno oggetti vicino
ai bordi della scena. Dopo vi è il livello
testo che contiene sia la didascalia per
questo fumetto sia la casella in cui essa
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sta. Anche quel livello è bloccato per
evitare che possa spostarlo
accidentalmente quandomodifico altre
parti del fumetto.

Sotto quello c'è il livello Content. In
molti dei miei fumetti questo viene
usato come un livello normale a sé
stante, con tutti i personaggi principali
e gli oggetti che vengono piazzati
direttamente entro di esso. In questo
caso, volevo essere in grado di
nascondere varie parti del disegno
mentre stavo lavorando su di esso, così
il livello Content è solo un contenitore
per vari sub-livelli. Dentro ciascuno di

questi sub-livelli gli oggetti sono
raggruppati, cosicché il livello Towers
contiene tre gruppi, uno per ciascun
livello. Ciòmi ha consentito di spostare
ciascuna torre individualmente,
sebbene ancora mi dia l'opzione di
nasconderli all'istante.

Il livello Backgrounds contiene tutto
il resto che è visibile all'interno
dell'immagine del fumetto, inclusi le
pareti dell'arena e l'orizzonte collinare.
Il livello Border, ancora una volta
bloccato, contiene un bordo comune
che utilizzo coi miei fumetti che
contiene informazioni sulla licenza,
l'URLdelmio sito web e un'ombra
proiettata.

Questi ultimi due livelli sono
particolarmente interessanti perché
entrambi contengono oggetti
pesantemente sfumati. Le sfumature
sono implementate come filtri SVG, che
saranno trattati in un articolo futuro,
ma a questo stadio è utile sapere che i
filtri possono esserematematicamente
intensivi e possono rallentare
significativamente la velocità di
rendering di Inkscape. Uno dei modi
migliori di evitare questo rallentamento
è nascondere il livello che contiene gli
oggetti filtrati. Inkscape non deve
disegnarli, così non fa le operazioni
matematiche richieste e può
rappresentare la vostra immagine

molto più rapidamente.

Quando disegnate un'immagine
complessa, potreste scoprire che
dovete spostare gli oggetti tra i livelli.
Ciò non può essere fatto dalla finestra
livelli ma è gestito, invece, dalmenù
Layero da una scorciatoia da tastiera.
Selezionate gli oggetti che volete
spostare e usate Layer>Move Selection
to layerAbove (MAIUSC+ PaginaSu) o
Layer>Move Selection to LayerBelow
(MAIUSC+ PaginaGiù).

Un'altra opzione che vedrete nel
menù Layer è Duplicate Current Layer.
Questa, non soltanto duplica il livello
stessoma anche tutti gli oggetti dentro
il livello, incluso qualunque sub livello e i
suoi contenuti. Poiché gli oggetti
duplicati appaiono direttamente in
cima agli originali, non è sempre ovvio
che siano state create delle copie, così
siate un po' attenti quando usate
questa opzione. Potete anche
duplicare i livelli direttamente dentro la
finestra Layers utilizzando ilmenù
contestuale sul nome del livello.
Sebbene ilmenù contestuale offra
un'opzione “Rename Layer...”, di solito
è più facile fare clic sul nome di un
livello selezionato che si trasforma in un
campomodificabile.

Una strana omissione dalmenù
contestuale è l'opzione pereliminare

un livello. Questa è disponibile tramite
la voce di menù Layer>Delete Current
Layero dal pulsante rossomeno nella
finestra. Attenti che questo cancellerà il
livello e tutto all'interno di esso, incluso
i sub-livelli, senza nessun ulteriore
suggerimento. Se eliminate
inavvertitamente un livello dopo non
tutto è perduto, dato che Edit>Undo
(CTRL+Z) lo ripristinerà.

Terminiamo il nostro tourdella
finestra Layers con i controlli al fondo. Il
regolatore Opacity funziona alla stessa
maniera di quello nella finestra Fill and
Strokema si applica a tutti gli oggetti
nel livello selezionato. È ancora un altro
dei molti modi di Inkscape di rendere
invisibili gli oggetti.

Il pop-up Blend Mode definisce
come viene disegnato il livello
selezionato rispetto ai livelli sotto di
esso. Proprio come il regolatore Blur
nella finestra Fill and Stroke, è di fatto
una scorciatoia per aggiungere un filtro.
Lemodalità di miscela offerte sono
Normal, Multiply, Screen, Darken e
Lighten, sebbene raramente vi sia
molta ragione di usare qualunque altra
al di fuori di Normal. So di un artista che
mette tutte le ombre delle sue
immagini dentro un singolo livello che è
impostato a Multiply e ho anche usato
la modalità Multiple perprodurre una
immagine anaglifo in 3D dello space
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shuttle. In questa immagine ho usato
quell'anaglifo space shuttle per
dimostrare le differenze tra le modalità
di miscela ma l'effetto reale prodotto
dipende altamente dai colori con cui
cominciate.

Vi è rimasto un solo aspetto da
menzionare della gestione del livello : il
menù pop-up sulla barra di stato.
Questo vi consente di cambiare
rapidamente tra i livelli e di nascondere,
mostrare, bloccare o sbloccare il livello
attuale utilizzando i pulsanti alla sinistra
del pop-up.

La puntata precedente ha
presentato questo pop-up nel contesto
della gestione dei gruppi. Questo è un
effetto collaterale del fatto che i livelli
sono solo dei gruppi con un po' di meta
dati extra. In questo caso il nome sul
pulsante sarà in effetti l'ID interno del
gruppo e potete usare ilmenù per
uscire da un gruppo cambiando a un
gruppo genitore o direttamente a un
livello interamente diverso. Ciò può
essere particolarmente utile se vi
trovate in una raccolta di gruppi
profondamente annidata dato che esso
provvede un meccanismo per saltare
indietro di parecchi passi alla volta.

Attenti, comunque, che usare i
pulsanti Hide o Lockquando avete
selezionato un gruppo può essere
pericoloso, risultando in gruppi nascosti
che non potrete rivelare facilmente o
gruppi bloccati che non potrete
sbloccare prontamente. Per questa

ragione tendo a usare soltanto i
pulsanti Hide e Locknella finestra
Layers o almeno, prima di usarli dalla
barra di stato, controllo due volte di
non essere dentro un gruppo.

Collegamenti

I fumetti usati in questo tutorial, più
i loro file sorgente di Inkscape, possono

essere scaricati da:
http://www.peppertop.com/fc/

http://www.peppertop.com/
http://www.peppertop.com/fc/
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L a dispensa precedente includeva
una striscia a fumetti realizzata con

Inkscape utilizzando tracciati, ellissi e
rettangoli con colori uniformi e
gradienti, tutti elementi che sono già
stati trattati in questa serie. Ma
includeva anche un altro tipo di oggetto
che è un elemento essenziale di molte
immagini: il testo.

Creare oggetti di testo in Inkscape
non è difficile ma presuppone alcuni
avvertimenti che possono far toppare
facilmente i principianti. Alcuni di questi
sono comuni a tutti i programmi di
grafica vettoriale, ma il primo problema
che probabilmente affronterete è
peculiare di Inkscape e implica una
breve lezione di storia...

Il formato di file nativo di Inkscape è
SVG, un formato aperto specificato dal
World WideWeb Consortium (W3C).
Utilizzando un formato aperto, Inkscape
crea file che possono essere visualizzati
e modificati, almeno in una certa
misura, in una vasta gamma di
applicazioni. Questo è un beneficio
enorme per l'utente, i cui file non
vengono vincolati ad essere usati solo
con Inkscape, ma ha lo svantaggio che
gli sviluppatori di Inkscape hanno poco

controllo diretto su ciò che è in grado di
modificare la specifica e ciò che non lo
è.

La prima versione della specifica
SVG è stata rilasciata nel 2001 , seguita
dalla versione 1 .1 nel 2003. Dopo di che,
sono passati parecchi anni di lavoro
sulla versione 1 .2, al fine di includere
molte aggiunte e miglioramenti, incluse
estensioni per supportare i testi che
vanno a capo riposizionandosi per
riempire il proprio contenitore. Gli
sviluppatori di Inkscape hanno
impiegato parecchio tempo a
implementare il supporto per questo
formato di “testo dinamico”,
anticipando completamente il suo
rilascio ufficiale nel nuovo standard
SVG.

Poi SVG 1 .2 è avvizzito ed è morto.
Non è mai diventato uno standard e
fino ad oggi - 8 anni dopo! - SVG 1 .1 è
ancora l'ultima versione ufficiale delle
specifiche SVG. Ciò ha lasciato ad
Inkscape la capacità di creare oggetti
che sono compatibili con una specifica
di fatto abortita ma, dato che questa
caratteristica è stata inserita in una
versione di rilascio del software, essa
infrangerebbe la compatibilità con i file

degli utenti qualora il codice fosse
semplicemente omesso. Gli sviluppatori
di Inkscape hanno preso la decisione
pragmatica di lasciare al suo posto la
caratteristica “Flowed Text” (Testo
Dinamico), anche se usarla creerà file
che altre applicazioni non
comprenderanno completamente.

Come risultato di questo problema
storico, Inkscape può creare testo in
due forme differenti: il tipo SVG 1 .1 , che
non si riposiziona automaticamente nel
suo contenitore (al quale mi riferirò
come Testo SVG) e il tipo SVG 1 .2 che si
riposiziona (Testo Dinamico), ma che
non è conforme alla specifica SVG. Il
problema sorge perché è fin troppo
facile creare accidentalmente del Testo
Dinamico, specialmente se avete
esperienze precedenti con altre
applicazioni grafiche.

Andiamo sul pratico e
creiamo davvero del testo.
Per prima cosa selezioniamo

lo strumento Text facendo clic sulla sua
icona nella tavolozza degli strumenti o
premendo “T” o F8.

Adesso, fate clic dentro la finestra di
disegno e iniziate a digitare. Se non

riuscite a vedere niente, controllate
tramite la barra di stato che le vostre
impostazioni di colore e opacità
abbiano un senso. Congratulazioni,
avete appena creato del Testo SVG. Se
ritornate allo strumento Select
utilizzando la tavolozza degli strumenti
o il tasto F1 , potrete spostare, scalare,
deformare e ruotare il vostro oggetto di
testo allo stesso modo di qualunque
altro elemento SVG. Poiché questo tipo
di oggetto testo è conforme a SVG 1 .1 ,
esso può essere visualizzato o
modificato da varie altre applicazioni.
Come potete vedere da questa
immagine, anche il deformare e il
ruotare l'oggetto di testo in Inkscape
(destra) non è sufficiente per impedirne
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la visualizzazione in Firefox (sinistra):

Alcune altre applicazioni grafiche
richiedono che trasciniate un rettangolo
sulla tela per contenere il vostro testo.
Ciò è comune specialmente nei
programmi di impaginazione come
Scribus, dove quasi tutto viene definito
disegnando una cornice che possa
contenerlo. Potete farlo anche in
Inkscape; selezionate lo strumento
Text, poi fate clic e trascinate un
rettangolo sulla tela prima di digitare.
Adesso avete creato un oggetto Testo
Dinamico. Con lo strumento Text
ancora attivo e l'oggetto Testo
Dinamico selezionato, dovreste vedere
una piccola maniglia quadrata in basso a
sinistra della cornice del testo.
Muovendo questa maniglia potete
cambiare dimensione e forma della
vostra cornice e il testo si riposizionerà
automaticamente. L'immagine
seguente mostra lo stesso oggetto
Testo Dinamico duplicato un paio di
volte in Inkscape. Le copie sono state
modificate solo nella dimensione della
loro cornice e potete facilmente vedere
che il testo si è spostato tutt'attorno e,

nel caso della cornice in basso a destra,
è stato troncato in automatico:

Se carichiamo questo file SVG
dentro Firefox il risultato è una pagina
vuota. Firefox ignora completamente il
Testo Dinamico e lo stesso vale per
quasi tutte le altre applicazioni.
Ricordate, la differenza tra creare Testo
SVG e Testo Dinamico è semplice
quanto fare solo clic o clic&trascina. Se
voleste usare i vostri file SVG in altre
applicazioni, dovrete fare quasi sempre
solo clic quando create i vostri oggetti di
testo. Se siete in dubbio, selezionate il
vostro oggetto di testo e controllate la
barra di stato che vi descriverà l'oggetto
o come “Text”, o come “Flowed Text”.

A dispetto del tono dei precedenti
pochi paragrafi, vi sono a volte valide
ragioni per usare il Testo Dinamico. Se
non volete utilizzare il vostro file
Inkscape in un'altra applicazione, allora
la presenza di codice SVG non standard
non vi influenzerà. Anche se volete
usare il vostro file SVG altrove, a volte
può essere più facile creare Testo
Dinamico durante la fase di disegno e
poi convertirlo in testo SVG utilizzando
Text > Convert alla voce di menù Text
soltanto prima di salvare la versione
finale del vostro file. Caricare il file
dentro Firefox vi darà esattamente il
risultato atteso:

Il vero vantaggio del Testo Dinamico
in Inkscape è che esso può riposizionarsi
in forme che non siano semplici
rettangoli. Per prima cosa vi servirà una
forma affinché il testo vi si riposizioni
dentro: questa può essere una qualsiasi
delle primitive semplici di Inkscape
come rettangoli, ellissi e stelle, oppure
un elemento tracciato che vi consenta
di creare forme complesse utilizzando
tutte le operazioni Booleane e gli
strumenti permodificare i nodi che
sono stati descritti negli articoli
precedenti. Comunque deve essere un
oggetto singolo, non può essere un

gruppo. Vi servirà anche del testo ma a
questo stadio non importa se create
Testo SVG o Testo Dinamico.
Selezionate sia la vostra forma che il
testo e poi usate il Text>Flow nelmenù
Frame per eseguire la magia. Notate
che ora la barra di stato descrive il
vostro oggetto testo come “Linked
flowed text” e che potete modificare la
vostra forma tante volte desiderate,
con il testo che si riposiziona per
adattarsi:

Come con il normale Testo
Dinamico, questo non sarà digerito da
altre applicazioni SVG. Potete usare
ancora Text>Convert to Text, sebbene
con tracciati molto complessi potreste
scoprire che il testo si sposta di molto
durante la conversione. Nonostante
tutto, per le etichette e i fumetti per
dialoghi, la capacità di cambiare la
forma dei vostri contenitori e avere il
testo che si riposiziona per adattarsi,
può essere un vero salva tempo.



full circle magazine #70 25 indice ^

HOWTO - INKSCAPE Parte 1 0

Adesso che sapete come creare
oggetti testo di base nelle loro varie
forme, è il momento di esercitare un po'
più di controllo sullo stile delle vostre
parole. Più comunemente, vorrete
scegliere un font adatto, impostarne la
dimensione e magari cambiarne la
giustificazione. Tutte queste opzioni
sono disponibili dalla Tool Control Bar
(barra di controllo degli strumenti) e,
sebbene possano essere cambiati in
qualunque momento, è spesso più
facile impostarli prima di fare clic (o clic-
trascina) per collocare il vostro cursore
del testo, per evitare problemi di
erronea messa a fuoco del testo
quando iniziate a digitare.

Il menù a discesa a sinistra della
barra degli strumenti vi permette di
selezionare un font. Inkscape sa essere
un po' esigente in fatto di font, così
potreste scoprire che alcuni font del
vostro sistema non sono disponibili,
specialmente quelli che non sono stati
creati da fonderia tipografica
professionale. C'è anche un problemino

occasionale che può capitare quando
aprite per la prima volta questo menù:
Inkscape ne mostra una versione
accorciata, con elencati solo alcuni font.
Se accade ciò, basta fare clic lontano dal
menù per chiuderlo e poi riaprirlo.
Infine, potreste scoprire che alcuni font
semplicemente si rifiutano di rimanere
selezionati quando sono scelti da
questo menù. Solitamente, ho questo
problema con “Arial Black” che Inkscape
immediatamente rimpiazza con una
versione grassetto di “Arial”. In questo
caso, potete usare la sotto finestra
“Text and Font” dal menù Text per
selezionare quel carattere cocciuto, che
verrà usato quando farete clic sul
pulsante Apply.

Il menu a discesa della dimensione vi
permette di sceglierne una tra quelle
predefinite, tutte in unità di “pixel SVG”.
Potete anche digitare direttamente in
questa casella per specificare una
dimensione differente, ma non c'è
modo di utilizzare qualunque altra unità.
I due pulsanti che seguono sono dei
pulsanti a due posizioni, utilizzati per
passare alle versioni grassetto o corsivo
del font selezionato, o a una versione
grassetto-corsivo, se entrambi sono
attivi.

Infine, vi sono quattro pulsanti per
impostare la giustificazione del testo. Le
giustificazioni a sinistra, centrata e a
destra possono essere usate per
qualunque parte di testo, ma la
giustificazione completa (dove il
programma cerca di allineare sia l'inizio
che la fine di ogni riga) è disponibile solo
per il testo dinamico. Potete convertire
il testo dinamico completamente
giustificato in testo SVG, il che fa un
lavoro sorprendentemente buono nel
mantenere la giustificazione, ma
produce scompiglio con la modifica del
testo sulla pagina di Inkscape, se
successivamente doveste cambiarne il
contenuto.

Avendo creato i vostri oggetti testo
in Inkscape, potreste voler trasferire il
file SVG in un'altra macchina, o postarlo
online. Nel farlo, vi è una buona
possibilità che vi imbattiate in un
problema con i fontmancanti. Il testo
nei file SVG è conservato come una
stringa di caratteri, insieme con delle
informazioni di stile che contengono il
nome del font. Se sul computer
destinazione non è presente un font
che abbia lo stesso nome, il software
utilizzato per aprire il file lo sostituirà
con un'alternativa, spesso con effetti
drammatici per l'aspetto della vostra

immagine. L'immagine seguente
mostra un paio di pannelli da una delle
mie strisce di fumetti, prima come
dovrebbe apparire usando un paio di
font da fumetto commerciali e poi
come appare su una Ubuntu box che
non ha installati quei font.

Vi sono quattro possibili soluzioni a
questo problema:
• Assicurarsi che i font richiesti siano
presenti anche sulla macchina di
destinazione. Ciò potrebbe non essere
possibile se il computer non è vostro, o
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se la licenza dei font lo proibisce.
•Non usare il formato SVG per trasferire
i file ad altri sistemi. Per i miei fumetti,
esporto sempre una versione PNG del
file per assicurarmi che i miei lettori
vedano una rappresentazione
dell'immagine perfetta in ogni pixel.
Esportare ad altri formati sarà il
soggetto della parte 1 2 di questa serie.
•Usare solo font comunemente
disponibili. Non è la soluzione perfetta,
ma potrebbe essere fattibile in alcune
circostanze. Il mio fumetto “Greys”, per
il quale rendo disponibili i file per il
download, usa l'onnipresente font
“Arial” per questa ragione. Anche con
questa precauzione spesso vengono
visualizzati malamente nel bowser e,
sebbene questo approccio renda più
facile aprire i file in Inkscape, produco
comunque una versione in PNG a
beneficio dei lettori occasionali.
•Convertire il vostro testo in tracciato
prima di salvare il file.

Quest'ultima soluzione è tanto
semplice quanto selezionare il testo e
poi la voce di menù Path>Object to
Path. Con Inkscape 0.48 il vostro testo
sarà rimpiazzato da tracciati di identico
aspetto, uno per ciascuna lettera,
raggruppati insieme. Le versioni
precedenti producevano
semplicemente un singolo tracciato
composito che conteneva tutte le
lettere. Una volta convertito in tracciati,

il testo è solo un'altra raccolta di forme
nel vostro file SVG e non richiede più
che i font siano installati.

Potrebbe sembrare una soluzione
ideale ma presenta uno svantaggio: il
vostro “testo” non è più un oggetto
testo, così non può più essere
modificato utilizzando lo strumento
Text in Inkscape. Se decidete di usare
questo approccio, vi raccomando di
effettuare la conversione in tracciati più
tardi possibile. Dovreste fare anche una
copia dell'oggetto testo prima di farlo,
nel caso abbiate bisogno di modificarlo
ancora in una data successiva. L'oggetto
testo dovrebbe poi essere messo in un
livello nascosto, o messo alle spalle di
qualche altro oggetto, o reso
trasparente o nascosto in qualche altra
maniera così che non interferisca con la
rappresentazione del file sulla macchina
di destinazione.

http://www.peppertop.com/
http://fullcirclemagazine.org/
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I n questa dispensa continueremol'esame degli strumenti di testo di
Inkscape. In precedenza avete appreso
come creare Testo SVG (conforme alla
specifica SVG 1 .1 e supportato in molte
altre applicazioni) e un paio di modi per
creare Testo Dinamico (non
compatibile con nessuna specifica
ufficiale SVG quindi, in pratica, di uso
ristretto all'interno di Inkscape).
Qualunque genere di testo usate,
quando è selezionato lo strumento
Text, vi viene presentata la stessa Barra
di Controllo degli Strumenti. La volta
scorsa abbiamo guardato la metà
sinistra di questa barra degli strumenti,
dove potete selezionare un font,
dimensione, stile e giustificazione.

Abbiamo usato questi controlli per
scegliere le impostazioni per un intero
blocco di testo alla volta ma Inkscape vi
lascia anche applicaremolte di esse a
parole o caratteri individuali all'interno
di un oggetto testo. L'ovvio uso per
questo è l'enfatizzare particolari parole
rendendole in grassetto, corsivo o
grassetto e corsivoma potete anche
cambiare font, dimensione e colore di
parti del vostro testo, nel caso ne
abbiate bisogno.

Per cominciare, dovete avere del
testo da modificare. Se siete a corto di
idee su cosa digitare perché non
provare l'estensione Lorem Ipsum, che
genererà paragrafi del classico assurdo
testo latino che i tipografi usano
tradizionalmente come un segnaposto.
Selezionate semplicemente la voce di
menù Extensions > Text > Lorem
Ipsum, scegliete alcuni valori dai tre
campi e fate clic su Apply. Verrà creato
un oggetto Testo Dinamico su un
nuovo livello, con la casella dinamica
impostata alle dimensioni della pagina.
Potreste voler cambiare la dimensione
della casella dinamica facendo doppio
clic sul testo e poi muovendo la piccola
maniglia a diamante in basso a destra
oppure potreste farlo fluire in un nuovo
oggetto usando il Text > Flowdentro il
menù Frame che abbiamo guardato
l'ultima volta.

Con lo strumento Text selezionato,
fate clic nel testo dinamico nel punto in
cui vi piacerebbe piazzare il cursore di
modifica del testo (da ora in poi userò il
termine indicatore perdifferenziarlo da
cursore delmouse o dai tasti cursore

sulla tastiera). In alternativa, se lo
strumento Select è attivo, potete fare
solo doppio clic nel testo dinamico per
posizionare l'indicatore e commutare
allo strumento Text in una volta sola.

Con l'indicatore che lampeggia
allegramente in mezzo al vostro testo,
dovreste essere in grado di spostarlo
utilizzando i tasti cursore, proprio come
fareste in un editor di testo. Premere i
tasti Inizio e Fine farà saltare
l'indicatore rispettivamente all'inizio e
alla fine della riga attuale, tenere
premuto il tastoMaiuscmentre si
effettua uno di questi movimenti,

selezionerà l'appropriata sezione di
testo. Anche ilmouse ha le sue funzioni:
fate clic perposizionare
immediatamente l'indicatore o fate clic-
trascina per selezionare una sezione
contigua di testo. Doppio clic per
selezionare una parola, triplo clic per
selezionare un'intera riga.

Con una porzione di testo
selezionata, è ilmomento di giocare
con lo stile. Iniziate selezionando il
riempimento con un colore diverso o
magari aggiungendo un contorno.
Potete impostare la larghezza del
contorno e il tipo di spigolo utilizzando
la finestra Fill and Strokema
aggiungeremarcatori non avrà effetto.
Altre parti della finestra influenzano il
testo in modi diversi: potete impostare
un livello alfa sul riempimento o sul
contorno perdargli della trasparenza
ma cambiare le impostazioni
dell'opacità non ha effetto. Se cercate
di usare sfocatura, gradienti o motivi,
scoprirete che viene influenzato l'intero
oggetto di testo, piuttosto che la
sezione selezionata. Impostare uno
stile tratteggiato sul contorno
influenzerà anche l'intero oggetto
testo, sebbene non lo noterete su
nessuna parola che non abbia applicato
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il contorno.

Sulla barra di controllo del testo,
potete cambiare il font per la selezione,
modificare la sua dimensione o usare i
pulsanti grassetto e corsivo. I pulsanti
per la giustificazione funzionano
soltanto per l'intero oggetto testo, non
per selezioni singole. Ciò significa che,
se volete giustificare a sinistra un
paragrafo e giustificare a destra il
successivo, dovrete dividerli in due
oggetti testo separati. Nondimeno,
giocando coi font, riempimento e altro,
potete creare facilmente alcuni disegni
di testo davvero notevoli.

Adesso che avete la destrezza di
posizionare l'indicatore e selezionare
parti del testo, è ilmomento di

esaminare le icone e i controlli usati
meno frequentemente che rimangono
sul resto della barra.

Il primo di questi potete
riconoscerlo come Superscript e
Subscript. Sebbene potete applicarli a
un intero oggetto testo, essi
funzionanomeglio su una selezione di
pochi caratteri alla volta. Hanno
l'effetto di ridurre la dimensione del
font per la selezione e di regolare la
base del testo in su o in giù. Di
conseguenza la dimensione può essere
modificata utilizzando la barra degli
strumenti, ma regolare la posizione non
è così semplice perciò, sebbene questi
pulsanti siano utili per testi sopra e
sotto, come le formule chimiche, non
sonomolto utili se volete posizionare
accuratamente il vostro testo.

Il posizionamento accurato è
precisamente ciò a cui si riferiscono i
successivi sei controlli. I primi tre
funzionano sia su Testo SVG che su
Testo Dinamico, mentre gli ultimi tre
sono disabilitati per gli oggetti Testo
Dinamico. Il primo ha tutto a che fare
con la spaziatura generale del testo, il
secondo consente un controllo
accurato sui caratteri singoli.

Il primo dei controlli della spaziatura
influenza la spaziatura fra le righe nel
paragrafo di un testo. Il valore qui
dentro vienemoltiplicato per la
dimensione del font allo scopo di
produrre la spaziatura finale. Potete
abbassarlo fino a 0, nel qual caso tutte
le righe saranno le une in cima alle altre,
ma non sono consentiti valori negativi e
quindi non potete usarlo comemodo
per far andare i paragrafi dal basso
verso l'alto. Tipicamente è impostato a
1 .25 per i paragrafi normali, sebbene
potreste desiderare di regolarlo per un
disegno più stretto. Quest'immagine
mostra tre paragrafi del nostro testo
Lorem Ipsum impostato
rispettivamente a 0.75, 1 .25 e 2.0.

I successivi due controlli vengono
usati per impostare la spaziatura
standard tra due lettere singole e la
spaziatura tra parole. I suggerimenti

affermano che entrambi questi valori
sono in pixelma, nella mia esperienza,
digitare un valore direttamente dentro
questi – anche se il vostro documento è
impostato per usare i pixel come unità
predefinite –ha come risultato che il
valore viene convertito in qualcosa di
diverso. In pratica non è un problema
troppo grande, dato che è raro
necessitare di valori specifici in questi
campi. Solitamente vorrete regolarli in
su o in giù per rendere il vostro testo un
po' più ampio o stretto. Questi campi vi
consentiranno di inserire valori negativi,
se volete davvero che il vostro testo
vada all'indietro.

Il controllo successivo è utilizzato
per regolare la crenatura orizzontale sul
Testo SVG. Crenatura (kerning) è il
termine usato perdescrivere la
spaziatura tra due caratteri singoli.
Regolando la crenatura, potete
predisporre i caratteri disponendoli un
po' più ordinatamente, dando al testo
un aspetto più piacevole, con meno
aree vuote che possano formare
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“fiumi” visivi di bianco su una pagina.
Usare questo campo è tanto semplice
quanto sistemare l'indicatore tra la
coppia di lettere cui desiderate
impostare la crenatura e poi inserire un
valore per regolare la spaziatura. Sono
più comunemente usati valori negativi,
per incoraggiare il secondo carattere ad
avvicinarsi verso lo spazio bianco vicino
al primo, ma potete anche usare un
valore positivo per forzare un paio di
caratteri ad essere più distanziati.
Questa immaginemostra l'effetto su
alcune coppie di caratteri senza
nessuna crenatura e poi con un valore
negativo.

Dopo il controllo della crenatura
orizzontale, vi è un campo similare per
regolare lo spostamento verticale dei
vostri caratteri. Se posizionate
semplicemente l'indicatore, esso
sposta il testo da quel punto alla fine
della riga su o giù. In alternativa potete
selezionare caratteri specifici o parole
per limitarne gli effetti, sebbene, se la
vostra selezione si espande perpiù di
una riga, il comportamento possa
essere un po' inaspettato. Valori
negativi in questo campo sposteranno
il vostro testo in alto, numeri positivi lo

sposteranno in basso. In combinazione
col cambiamento della dimensione del
font, ciò può darvi un controllo più
accurato di quanto ottenete dall'usare i
pulsanti Superscript e Subscript.

L'ultimo di questo gruppo di
controlli vi permette di ruotare caratteri
singoli, col valore che è una figura in
gradi. I numeri positivi ruotano in senso
orario, i numeri negativi in senso
antiorario. Posizionare il cursore
provocherà la rotazione solo del
carattere seguente. Selezionando del
testo ruoteranno i caratteri singoli della
selezione, non l'intrea selezione come
un tutt'uno. Non è possibile selezionare
il centro di rotazionema, se ne avete
bisogno, in compenso potete usare i
controlli di crenatura orizzontale e
spostamento verticale.

Nella pratica, i controlli di crenatura
orizzontale, spostamento verticale e
rotazione dei caratteri vengono spesso
regolati meglio utilizzando scorciatoie
da tastiera. Tenere premuto ALT
mentre si usano i tasti cursore regolerà
la crenatura e lo spostamento verticale,
mentre ALT-] e ALT-[ possono essere
usati per la rotazione dei caratteri. La
voce di menù Text>RemoveManual
Kerns rimuoverà tutte le regolazioni di
crenatura orizzontale, spostamento
verticale e rotazione dei caratteri per
l'intero oggetto testo, ma non

rimuoverà alcun cambiamento ai
controlli della riga, della spaziatura di
lettera o parola. I pulsanti finali sulla
barra degli strumenti vi faranno
commutare tra creare testo orizzontale
e verticale. Nel secondo caso, i caratteri
singoli sono per il verso giustoma le
parole scorrono giù per la pagina in
verticale –all'opposto del ruotare
semplicemente l'oggetto testo, nel
qual caso anche i caratteri vengono
ruotati.

C'è un grosso elefante nella stanza
che non può non essere trascurato
quando si discute di testo e file SVG: i
font SVG. La specifica SVG include un
formato di font dove i singoli glifi
vengono definiti usando oggetti SVG
standard. In teoria, ciò dovrebbe
consentire che vengano creati font
contenenti colore e animazioni e che
possano essere cambiati
dinamicamente utilizzando del codice
Javascript standard in un web browser,
il tuttomentre ancora presentano del
contenuto di testo comprensibile ai
motori di ricerca. Sebbene Inkscape
contenga un'interfaccia dedicata per
creare font SVG, tramite ilmenù Text >
SVG Font Editor, vi sono un paio di
ragioni perché 'probabilmente' non
valga la pena usarlo. La prima è che gli
sviluppatori di Firefox hanno
specificatamente respinto l'idea di
supportare i font SVG a causa della loro

mancanza di un qualche layout e
caratteristiche di internazionalizzazione
che sono disponibili in altri formati di
font. Le loro preoccupazioni sono
certamente valide per un formato di
font di uso generale ma io penso che si
perdano alcuni dei vantaggi che i font
svg possono offrire quando vengono
usati in una immagine SVG e che nessun
altro formato può.

Una ragione anche più grande per
non usare font SVG è, ironicamente,
Inkscape stesso. Sebbene abbia
un'interfaccia per aiutare a crearli, non
ha in realtà un meccanismo perusarli,
una volta che sono stati creati. Il font
Editor, quindi, è utile soltanto se state
creando font SVG come passo
provvisorio verso la generazione di un
font True Type o Postscript utilizzando
un'applicazione come Font Forge.

http://www.peppertop.com/
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I nkscape è un buon programma per lacreazione di immagini, diagrammi e
disegni ma, ad un certo punto,
probabilmente vi serviranno in un altro
formato rispetto alla variante di SVG
propria di Inkscape. Ci sonomolti
formati di importazione ed
esportazione in Inkscape, con la scelta
esatta che dipende anche da
applicazioni esterne. In questo articolo
vi introdurrò ai formati più comuni e
utili, che generalmente sono quelli che
si trovano tra i formati di file nella
finestra popup in File>Save As...
Iniziamo con un tipo di file molto
comune tra gli utenti di Inkscape: SVG.

Probabilmente non avretemai
pensatomolto a SVG come a un
formato per l'esportazione, ma solo al
fatto che è il formato predefinito di
Inkscape. In realtà Inkscape offre
addirittura sei varianti di SVG nella
finestra di dialogo 'Save As...', ed
ognuno propone compromessi diversi
tra dimensione e contenuto del file. Il
primo, chiamato semplicemente
'Inkscape SVG', è il formato predefinito
di Inkscape ed è quello che
probabilmente usate permemorizzare
gli originali dei vostri disegni Inkscape.
Questo formato preserva tutte le

informazioni specifiche di Inkscape, il
che ne facilita l'utilizzo come formato
nella fase di progettazione, ma
significa che la dimensione del file è
grossa e che conserva un sacco di
informazioni chemolte altre
applicazioni non comprendono.

Se la preoccupazionemaggiore è la
dimensione del file, ma si vuole che le
informazioni specifiche di Inkscape
siano comunque preservate, allora si
dovrebbe usare 'Compressed Inkscape
SVG'. Questo formato ha come
estensione svgz ed è identico a un file
SVG standard di Inkscapema
compresso usando l'algoritmo Gzip.
Tipicamente, ciò riduce le dimensioni
del file del cinquanta per cento circa o
più. Se dei file compressi vengono
corrotti sonomaggiormente soggetti a
perdite di informazioni ed alcune volte
non vengono visualizzati in applicazioni
che, per il resto, rappresentano bene i
file SVG. Alcuni browserdi rete non
visualizzano questi file se caricati da un
disco fisso locale, nonostante vengano
rappresentati bene se distribuiti da un
server di rete.

La maggiorparte delle altre
applicazioni non riconosceranno le

informazioni specifiche di Inkscape nei
file SVG, per questo è possibile salvare
una versione senza questi dati. Si tratta
dell'opzione 'Plain SVG' e la sua
controparte compressa con Gzip,
'Compressed Plain SVG'. Vi faranno
risparmiare qualche byte e
produrranno una versione SVG più pura
con cui è più facile lavorare se,
successivamente, dovretemodificarli a
mano o se volete usarli su un sito come
Wikipedia, dove i file SVG semplici sono
da preferirsi alle versioni di specifiche
applicazioni. Nonostante possa
sembrare il formato ideale per l'utilizzo
in rete, esso rimuove gli elementi
<script>, limitandone quindi le
possibilità di impiego per alcuni
contenuti.

Se volete davvero eliminare dai
vostri file ogni byte ridondante, allora
quello che fa per voi è l'opzione
'Optimized SVG' (in basso a destra).
Questa crea un output attraverso uno
script in Python chiamato 'scour', che è
anche disponibile come applicazione
autonoma. Propone una finestra di
dialogo che permette di regolare le
ottimizzazioni che verranno apportate
e, se il file è complesso, potrebbe
richiedere del tempo per concludere
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l'operazione.

Perottenere ilmeglio da Scourè
bene avere qualche conoscenza sulla
struttura dei file SVG. Nella finestra di
salvataggio di Inkscape non c'è alcuna
versione compressa disponibile per il
formato 'Optimized SVG', ma è
possibile comprimere con Gzip il file
SVG ottenendo gli stessi risultati.

L'ultimo formato SVG è
'Compressed Inkscape SVGwith
media'. Questo in realtà crea un file zip
(non Gzip) che contiene un file Inkscape
SVG ed una copia di ogni media
collegato. I file collegati solitamente
sono immagini bitmap che sono state
aggiunte al disegno, ma non
incorporate. Aggiungere grafiche
bitmap è un argomento di cui
tratteremo più avanti in questa serie.
Questo formato è utile per trasferire
un disegno Inkscape e tutti i media
collegati ad un'altra macchina ma,
ironicamente, per il ricevente non è
possibile aprirli con la sua copia di
Inkscape. Solamente dopo che il file zip
è stato decompresso è possibile aprire
il file SVG che è contenuto all'interno.

Per confrontare le dimensioni di
queste varianti di SVG, ho salvato una
copia del disegno del pupazzo di neve
proposto nella parte nove di questa
serie in ogni formato. Ho fatto lo stesso

anche con uno dei miei fumetti più
lunghi. Il formato “Compressed
Optimized SVG” è stato compresso
manualmente usando il codice 'gzip -9
filename.svg' per avere la
compressionemigliore e poi
l'estensionemodificata da 'svg.gz' a
'svgz'. Infine ho anche esportato
entrambi i file nel formato PNG per
mostrare la differenza in dimensione
(mostrata sopra) tra grafiche bitmap e
vettoriali.

Come potete vedere, le differenze
più significative le vediamo quando
l'immagine diventa più complessa e
grande; stiamo comunque parlando di
piccoli salvataggi in un'era di dischi rigidi
multi-terabyte. Se avete ragioni o
richieste particolari, come la modifica
manuale o l'utilizzo su siti come
Wikipedia, allora ha senso salvare file
puri, ottimizzati o compressi. Se avete
molto spazio a disposizione sul server di
rete, non è nemmeno necessario
comprimere i file per utilizzarli online:
piuttosto assicuratevi che il vostro

software nel server di rete sia
configurato perdecomprimere i dati al
volo con gzip. Nelmio caso uso il
formato compresso di Inkscape per i
file che possono essere scaricati dal
mio sito web, che ha più di 200 fumetti
pronti per essere scaricati e mi aiuta a
tenere bassi i costi d'archiviazione, ma
uso il formato non compresso di
Inkscape quando archivio i file sul disco
fisso locale.

Dopo SVG, il formato di
esportazione più comune è,
probabilmente, PNG. Questo è un
formato bitmap che può essere
mostrato da quasi tutti i browserdi rete
e i programmi di grafica. È l'unico

formato bitmap standard che Inkscape
può esportare, quindi se volete
convertire la vostra immagine in un file
JPEG, TIFF, Windows BMPo qualunque
altro tipo di grafica bitmap, il primo
passo sarà quello di creare un PNG e poi
convertirlo con un'altra applicazione.

Un erroremolto comune e
comprensibile che i nuovi utenti di
Inkscape commettono è quello di usare
l'opzione 'Cairo PNG' dalla finestra di
dialogo File > Save As...
Sfortunatamente questo non è quasi
mai ilmodo corretto di creare PNG, per
il fatto che non supporta la trasparenza
e i filtri. Piuttosto si dovrebbe usare la
voce delmenù File > ExportBitmap...
che aprirà la finestra di dialogo per
l'esportazione di PNG.

I quattro pulsanti in cima alla
finestra di dialogo sono comode
scorciatoie per scegliere quale parte
dell'immagine si vuole esportare: la
pagina intera, un rettangolo grande
abbastanza da racchiudere tutto il

Format Snowman Comic
Inkscape SVG 172KB 849KB
Plain SVG 154KB 769KB
Optimised SVG 133KB 504KB
Compressed Inkscape SVG 93KB 274KB
Compressed plain SVG 90KB 261KB
Compressed Optimised SVG 87KB 209KB
PNG exported at 90dpi 211KB 1400KB
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disegno (il quale potrebbe essere più
grande o più piccolo della pagina), un
rettangolo grande abbastanza per
raccogliere tutti gli oggetti che sono
selezionati almomento o un rettangolo
personalizzato la cui grandezza è
impostata dalle coordinate x0, x1 , y0 e
y1 . È possibile specificare un rettangolo
personalizzato con x0, y0, larghezza e
altezza, in questo caso x1 e y1 verranno
aggiornate automaticamente.

Di solito viene esportato tutto ciò
che è visibile sullo schermo e che giace
dentro il rettangolo specificato. Se si
vuole sia esportato solo l'oggetto
selezionato o il gruppo, senza elementi
dello sfondo, si può spuntare la casella
“Hide all except selected” in fondo alla
finestra. Se sono selezionati più di un
oggetto o gruppo si può usare la casella
“Batch export” per salvare ciascuno di
essi in un file separato.

La parte 'Bitmap Size' della finestra
di dialogo permette di impostare la
larghezza e l'altezza del file PNG che
sarà creato. Altrimenti è possibile
impostare i 'punti perpollice' o 'dpi'
(dot per inch), che cambiano
automaticamente i campi Width
(larghezza) e Heigth (altezza).
Aumentando i dpi si produrrà un file più
grande, con più pixel; riducendo i dpi si
ottiene un file più piccolo, con meno
pixel. Per la grafica web 90 dpi

solitamente sono sufficienti, ma si
potrebbe averbisogno di sfruttare 300
dpi per un file che dovrà essere
stampato. Se si vuole stamparlo grande
il doppio, si usino invece 600 dpi, o 1 50
dpi per una grandezza dimezzata. La
regola è la stessa delle fotocamere
digitali: maggiore è il numero di pixel e
maggiori saranno i dettagli, ma implica
una maggiore dimensione del file.

L'ultima parte di questa finestra di
dialogo, la sezione 'Filename', è un po'
ingannevole. È possibile digitare il
percorso e il nomema, qualunque sia il
nome usato, Inkscape produrrà sempre
un file PNG. In alternativa è possibile
fare clic sul bottone 'Browse...' che
porta al selettore di file. Il tranello sta
nel fatto che il selettore di file ha il
pulsante 'Save' che in realtà non salva
ancora il file. Semplicemente viene
inserito il percorso e il nome del file nel
campo 'Filename', ma l'immagine non
sarà realmentememorizzata su disco
finché non si fa clic sul pulsante
'Export'. Di solito l'esportazione è
abbastanza veloce, ma potrebbe
richiedere del tempo in caso di grandi
valori di dpi, o se l'immagine contiene
filtri complessi.

Tornando al selettore di file di 'Save
As...', le opzioni 'Portable Document
Format', 'PostScript' e 'Encapsulated
PostScript' sono tutte varianti di questo

tipo. Questi formati sonomolto utili
quando si creano file per una
stamperia, dove si aspettano di ricevere
file nei formati standard dell'ambiente.
Essi presentano tutti una finestra di
dialogomolto simile in cui scegliere tra
alcune opzioni.

Le opzioni più importanti sono
'Convert text to paths' e 'Rasterize filter
effects'. Lal prima converte
automaticamente in tracciati gli oggetti
di testo nel file esportato, in questo
modo si prevengono problemi causati
dall'utilizzo di tipi di carattere presenti
sulla propria macchina ma non su quella
di altri. Nessuno di questi formati
supporta gli effetti di filtri che offre
SVG, compresa la sfocatura semplice,
quindi se non si sceglie di rasterizzarli,
gli oggetti corrispondenti verranno
semplicemente omessi dal file. La
rasterizzazione consiste nella creazione
di una versione bitmap del contenuto a
cui è stato applicato il filtro cosi, molto
similmente alla finestra di dialogo

'ExportBitmap...', c'è l'impostazione dei
dpi. Anche qui un valore alto produrrà
maggiori dettagli nel file di output. Se
state cercando di creare un PDF da
vedere sullo schermo di un computer,
allora 90 dpi dovrebbero essere
sufficienti, ma se si vuole una stampa di
alta qualità o ci si aspetta che il lettore
lo ingrandisca allora, probabilmente,
dovrebbe essere impostato un valore
più alto.

Un modo alternativo per la
creazione di un PDF per la stampa è
quello di importare il vostro file SVG in
Scribus e usare questo per generare il
file PDF. Sfortunatamente Scribus non
supporta tutte le caratteristiche
dell'SVG di Inkscape, per cui questo
approccio potrebbe non funzionare per
disegni piuttosto complessi. La mia
esperienza personale è che spesso il
modo più facile è semplicemente
quello di esportare un file PNG ad alta
risoluzione e lasciare che sia la
stamperia a muoversi con i formati che
ritiene più opportuni. L'inconveniente
di questometodo, oltre al fatto che si
avrà un file grande, è che i vettori
vengono rasterizzati in anticipo e,
probabilmente, non si avrà la migliore
risoluzione. Perpiccoli supporti
potrebbe non essere un problema ma,
se i vostri piani sono quelli di creare
postero cartelloni, potrebbe fare la
differenza. I file PNG di Inkscape sono
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tutti nel formato RGB e alcune
stamperie pignole potrebbero
lamentarsi richiedendo file in CMYK.
Anche se sono disponibili a lavorare con
file PNG, assicuratevi comunque di farvi
fare una prova per controllare che i
colori stampati siano quelli che vi
aspettavate.

Ci sonomolti altri formati disponibili
nel selettore di file 'Save As...' e sono a
disposizione per usi particolari. Ognuno
di questi ha le proprie limitazioni
rispetto alle funzionalità dell'SVG
Inkscape, ma possono essere
comunque rappresentate. Permaggiori
dettagli riguardo questi formati si
legga la sezione 'Exporting Files' della
ottima guida di Tavmjong Bah (in fondo
all'articolo trovate il link). Visto il tipo di
lettori di Full Circle Magazine è bene
parlare anche di un altro formato:
'GIMPXCFmantainings layers'.

Questo formato di esportazione è
disponibile solo se GIMPpuò essere
trovato nel percorso di sistema. Per la
maggiorparte dei sistemi Linux, ciò
viene fatto in automatico se si installa il
programma con il gestore di pacchetti
o se esso è fornito come parte

dell'installazione predefinita. Una volta
che è disponibile se lo si seleziona
presenterà una finestra di dialogo con
alcune opzioni per l'esportazione.

Le opzioni 'Save Guides' e 'Save Grid'
fanno in modo che vengano incluse le
guide e la prima griglia di Inkscape, in
modo che siano disponibili anche per
GIMP. Non abbiamo ancora parlato di
guide e griglie in questa serie, ma se ci
avete avuto a che fare da soli, allora
queste opzioni potrebbero tornarvi
utili. Nella pratica, può essere comodo
avere le guide, ma la griglia apparirà
molto più densa rispetto a quella del
file originale di Inkscape e potrebbe
essere talmente densa da oscurare
l'immagine intera! Anche l'opzione
'Save Background' è un problema per il
fatto che applica il colore dello sfondo
al documento (impostato con Inkscape
in File > DocumentProperties ...) ad
ogni singolo livello, piuttosto che creare
un unico livello di sfondo. Ameno che
non abbiate particolari ragioni di fare
altrimenti, vi consiglio di lasciare
almeno le ultime due opzioni non
selezionate.

Caricare il file XCF risultante in
GIMPprodurrà esattamente ciò che vi
aspettate, una rappresentazione
bitmap del vostro file Inkscape con ogni
livello di Inkscape in corrispondenti
livelli di GIMP... o quasi.

Sfortunatamente qualsiasi sottolivello
viene rappresentato nel livello
genitore, piuttosto che rimanere in
livelli separati in GIMP. Se volete
mantenere separati i vostri sottolivelli,
è necessario promuoverli a livelli
primari, prima di esportare il file. Le
immagini create con questo tipo di
esportazione sono fissate a 90dpi, se
volete una immagine di dimensione
diversa dovete prima scalarla con
Inkspace.

Una alternativa alla creazione di file
XCF da Inkscape è quella
dell'importazione di un file SVG
direttamente in GIMP. Questo non
manterrà alcun livello, appiattendo
invece l'immagine in un livello unico.
Alcune caratteristiche più avanzate di
SVG o aggiunte specifiche di Inkscape
potrebbero non essere correttamente
riprodotte. Caricare il file SVG in GIMP
permette comunque di scegliere la
dimensione del bitmap rappresentato.

L'opzione 'Import paths' creerà un
tracciato perogni oggetto nel vostro

file SVG. Ciò potrebbe esservi utile se
volete convertire uno o più tracciati in
una selezione, in modo da limitare le
possibilità di modifica in GIMP. È buona
norma spuntare questa casella, anche
se non ne avete bisogno; potete
semplicemente ignorare i tracciati ma
averli disponibili potrebbe rendere
molto più facili alcunemodifiche.
L'opzione 'Merge imported paths' è
meno utile. Crea un tracciato perogni
oggetto nel file SVG e poi li unisce tutti
in uno singolo. In ogni caso potete
combinare più tracciati con una
selezione sola direttamente in GIMP,
lasciarli separati vi permetterà di unirli
in uno solo in un secondo tempo, se ne
avrete bisogno.

LINK:
Scour: https://launchpad.net/scour

“Exporting Files” nelmanuale di
Inkscape:
http://tavmjong.free.fr/INKSCAPE/MA
NUAL/html/File-Export.html

http://www.peppertop.com/
https://launchpad.net/scour
http://tavmjong.free.fr/INKSCAPE/MANUAL/html/File-Export.html
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D urante il corso di questa serie una
cosa di cui vi sarete

probabilmente accorti riguardo a
Inkscape è che opera con una pila di
oggetti posti uno sopra l'altro: lo "z-
order". Potete introdurre una qualche
struttura globale mettendo oggetti
dentro gruppi e livelli ma,
semplicemente, non è possibile creare
un elemento che passi sia sopra che
sotto un altro oggetto.

Poiché siamo maggiormente
interessati alla creazione di un risultato
artistico, la soluzione è,
semplicemente, mettere l'oggetto in
cima e rimuovere poi la parte che
verrebbe nascosta dietro il nostro
secondo oggetto. Un modo di
rimuovere la parte nascosta è
modificare i tracciati che rendono il
nostro oggetto problematico, magari
usando le operazioni Booleane per
tagliar fuori delle sezioni.

E se l'oggetto è complesso, come
un gruppo di molti elementi singoli che
dovrebbero essere tagliati ciascuno in
maniera indipendente? In questo caso
un'opzione migliore sarebbe dire a
Inkscape che deve disegnare solo certe
aree e lasciare trasparenti le altre

affinché l'oggetto di sfondo si mostri
attraverso. Ciò viene fatto creando un
tracciato e applicandolo come un "clip
path" ovvero un tracciato di fissaggio.
Qualunque parte dell'oggetto dentro il
tracciato sarà visibile, mentre le parti
che sono fuori non saranno disegnate
affatto.

Come esempio riesumiamo il
pupazzo di neve già utilizzato prima in
questa serie e diamogli una sciarpa.
Potremmo farlo semplicemente
disegnando sul pupazzo di neve la
parte davanti della sciarpa, ma in
questo caso forzato, la nostra sciarpa
ha già una sezione posteriore che
dobbiamo ritagliare dall'immagine
finale.

A dispetto del suo nome, un
tracciato di fissaggio non deve per
forza essere un tracciato. Può essere

una qualunque forma chiusa: un
rettangolo, un ovale, una stella o un
poligono. Può essere anche un
tracciato complesso che contiene
sotto-tracciati multipli (di questi si
parlerà di più in seguito). Qualunque
forma usiate, comunque, deve essere
un oggetto singolo piuttosto che un
gruppo o una selezione di diversi
elementi.

Definire un tracciato di fissaggio è
semplice: disegnate il tracciato o la
forma che volete, assicurandovi che si
trovi più in alto nello "z-order" rispetto

all'oggetto o al gruppo che volete
fissare. Adesso selezionate sia il
tracciato di fissaggio che l'oggetto che
volete fissare e usate l'opzione "Set
Clip" sul menù contestuale. La voce di
menù Object>Clip>Set ha lo stesso
effetto. Ecco, ho creato un ovale in
cima alla sciarpa. Di solito disegno i
miei tracciati di fissaggio con un
contorno verde brillante e senza
riempimento così che siano facili da
individuare contro l'oggetto che sto
fissando. Il colore è irrilevante, come lo
è lo spessore del contorno: è
esclusivamente la forma del tracciato
che viene usata per definire il fissaggio.
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Sfortunatamente, il risultato di
questo fissaggio è l'opposto
dell'effetto che stavamo cercando.
Invece di rimuovere il retro della
sciarpa, siamo rimasti con niente altro
che il retro della sciarpa!

Ricordate, il fissaggio lascia sempre
visibile il contenuto dentro il tracciato
di fissaggio e nasconde tutto fuori di
esso. Non vi è modo di invertire questo
comportamento per nascondere il
contenuto del tracciato, così invece,
dovete aggirarlo creando un tracciato
più complesso che faccia il lavoro per
voi. Questa è una opputunità ideale per
usare le operazioni Booleane che sono
state introdotte nalla Parte 7 di questa
serie. In questo caso disegnate un
rettangolo che sia largo abbastanza da
comprendere tutta la sciarpa poi,
assicurandosi che l'ovale sia in cima,

usate Path>Difference per "sottrarre"
l'ovale dal rettangolo.

Ad una prima occhiata questo
potrebbe sembrare semplicemente un
rettangolo con un ovale in cima ad esso
ma, in pratica, adesso questo è un
singolo tracciato complesso.
"Complesso" significa semplicemente
che è fatto di sotto tracciati separati. Il
rettangolo è un sotto tracciato e
l'ovale è un secondo sotto tracciato, ma
l'intero oggetto viene ancora
considerato essere un tracciato singolo
e può quindi essere usato per il
fissaggio. Ancora una volta rimarrà
soltanto l'area dentro il tracciato, ma in
questo caso "dentro" si riferisce allo
spazio tra l'ovale e il rettangolo; "fuori"
è qualunque cosa oltre il rettangolo o
entro l'ovale. Provate a impostare un
riempimento se la differenza tra
l'interno e l'esterno non è chiara.

Fissare con questo tracciato
complesso ci porta molto più vicino al
risultato desiderato.

Ricordate, questo è puramente un
effetto visivo. La sciarpa originale
rimane la stessa è solo che parti di essa
non vengono disegnate. Potete disfare
l'effetto in qualunque momento
selezionando un oggetto fissato e poi
scegliendo "Release Clip" dal menù
contestuale o Object>Clip>Release
dalla barra del menù principale. Ciò
riporterà l'oggetto al suo aspetto
normale e renderà anche di nuovo
visibile il tracciato di fissaggio.

Se aggiungiamo la sciarpa al
pupazzo di neve vedrete che siamo
vicini all'effetto che stiamo cercando
ma vi sono ancora parti della sciarpa
che vengono disegnate davanti la testa

del personaggio.

Il problema è che il tracciato di
fissaggio che abbiamo usato era solo
un'approssimazione e deve essere
ottimizzato per corrispondere più
strettamente alla sezione che vogliamo
nascondere. Nelle precedenti versioni
di Inkscape l'unico modo di far questo
era rilasciare il fissaggio, aggiustare il
tracciato, poi fissarlo di nuovo. Anche
con l'ultima versione questo è ancora
l'unica opzione se il vostro "tracciato"
di fissaggio è un rettangolo, stella,
ovale o un altro oggetto primitivo. Per
fortuna, sin dalla versione 0.48 di
Inkscape, le nostre operazioni
Booleane hanno trasformato la nostra
combinazione di un ovale e un
rettangolo in un tracciato a pieno titolo
che può essere modificato senza
rilasciare il fissaggio.

Per passare alla modalità di
modifica dovete selezionare l'oggetto
fissato (come al solito tenete d'occhio
la barra di stato dove un oggetto
fissato sarà descritto come tale), poi
passate allo strumento nodi, usando
l'icona sulla tavolozza degli strumenti o
premendo "n" o F2. Adesso dovreste
vedere il vostro tracciato di fissaggio
rappresentato come un tracciato verde
da un pixel, senza riguardo per il colore
o lo spessore del tracciato originale. Il
colore verde in questa modalità è la
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ragione per cui scelgo il verde brillante
quando disegno il mio tracciato: aiuta
a rinforzare il collegamento mentale
tra i tracciati verdi e il fissaggio. Se non
vedete il tracciato verde, assicuratevi
che il pulsante "Show clippong path(s)
of selected object(s)" nella tavolozza
degli strumenti di controllo sia attivo.

Da questo punto potete modificare
il tracciato usando gli strumenti nodo
che sono stati descritti nella Parte 6.
Potreste trovare più comodo ridurre
l'opacità dell'oggetto fissato così che
possiate vedere come il tracciato di
fissaggio si collega agli oggetti dietro. I
cambiamenti al tracciato di fissaggio
saranno applicati dal vivo, così potete
vedere il risultato mentre lavorate.
Una volta che avete terminato di
modificare, riportate l'opacità
dell'oggetto al 1 00%, se dovete, e
passate allo strumento selezione per
nascondere il tracciato di fissaggio
verde e vedere i risultati. Ricordate che
la barra spaziatrice può essere usata
come comoda scorciatoia per passare

allo strumento selezione e poi
ritornare allo strumento nodo durante
la modifca, se scoprite che i nodi vi
oscurano la visuale.

Con un po' di tempo passato sulla
modifica del nodo, dovreste essere in
grado di aggiustare il tracciato di
fissaggio per seguire la testa del
pupazzo di neve e far sembrare che la
sciarpa scompaia dietro di essa.

A volte potrete essere in grado di
cavarvela con un semplice rettangolo o
ovale come tracciato di fissaggio ma, di
solito, vale la pena premere CTRL-
MAIUSC-C (o usare Path>Object to
Path) prima di impostare il fissaggio,
semplicemente per il vantaggio di
essere in grado di modificare il
tracciato senza dover disimpostare e
poi reimpostare il fissaggio.

Poiché il
fissaggio dà come
risultato un bordo
duro, esso può
essere utilizzato
per creare alcuni
effetti che
altrimenti sarebbero molto difficili da
produrre. Dovunque dovete fermare
una sfocatura dal fuoriuscire sopra un
bordo, il fissaggio può fornire una
soluzione. Considerate qualcosa come
un semicerchio che dovrebbe essere

sfocato solo dal bordo incurvato e
tagliato di netto dal bordo dritto. Senza
fissaggio questa sarebbe una immagine
molto difficile da creare.

La capacità di ritagliare parti da un
oggetto sfuocato può portare ad
alcuni effetti particolarmente
interessanti quando viene utilizzata col
testo. Per ciascuno di questi esempi, ho
creato due copie di un oggetto di testo.
Una di loro è sfocata, mentre l'altra è
stata convertita in un tracciato e usata
per fissare la versione sfocata.
Differenti sistemazioni del tracciato di
fissaggio, sfocatura, testo, sfondo e
scelte di colore possono produrre una
varietà di risultati.

Il fissaggio
può anche
essere usato per
aggirare la
selezione
limitata dei tipi

di gradiente. Inkscape segue lo
standard SVG e supporta solo gradienti
lineari e radiali, ma altri tipi possono
spesso essere emulati attraverso un
uso attento di oggetti sfocati e tracciati
di fissaggio. In questo esempio, alcuni
segmenti sfocati e un tracciato di
fissaggio a forma di ciambella fanno un
sostituto accettabile per un gradiente
conico quando si disegna un CD.

Sebbene il fissaggio abbia molti usi
e sia una tecnica con cui vale sempre la
pena prendere confidenza, a volte vi
serve un po' più delicatezza dei bordi
duri che crea. La prossima volta
esamineremo la mascheratura, una
tecnica correlata che vi permette di
sfumare gli oggetti gradualemente,
piuttosto che interromperli
bruscamente al bordo di un tracciato.

http://www.peppertop.com/
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L a Trasparenza, o la sua controparte,
l'opacità, è un concetto così

fondamentale in Inkscape che è stato
uno dei primissimi argomenti trattati in
questa serie. Nella Parte 3 siete stati
introdotti alla casella di selezione
dell'Opacità sulla barra di stato la quale
vi dà la capacità di impostare un singolo
livello di trasparenza perun intero
oggetto o anche perun gruppo di
oggetti.

Se volete che un singolo oggetto
abbia opacità variabile, come
completamente trasparente ad un capo
e opaco all'altro, potete usare un
gradiente per riempimento e contorno.
Ma riguardo al fare lo stesso perun
gruppo di oggetti? Potreste impostare
separatamente dei gradienti adatti su
ciascun oggetto nel gruppo per
ottenere l'effetto desideratoma, se il
vostro gruppo contienemolti oggetti,
allora questo approccio diviene tedioso
molto rapidamente.

La soluzione a questo problema è la
mascheratura. Questa é una tecnica che
usa una immagine in scala di grigi come
mezzo per specificare l'opacità di un
altro oggetto o gruppo. Tutte le sezioni
bianche nell'immagine fanno in modo

che parte dell'oggettomascherato
appaia opaco. Le sezioni nere fanno in
modo che delle parti appaiano
trasparenti. E le grige in mezzo hanno
come risultato livelli variabili di opacità.

Diamo un'occhiata a un esempio. In
questa immagine (sotto) ho sistemato
un cerchio tutto rosso sopra uno sfondo
tutto verde. Il verde è là principalmente
permostrare l'effetto più chiaramente.
Sopra il cerchio vi è un rettangolo con un
gradiente bianco-nero-bianco. Usare
questo rettangolo comemaschera per il
cerchio dà il risultato di un cerchio
arrotondato che sfuma dall'opaco al
trasparente e da questo all'opaco.

Notate che qualunque cosa
all'esterno della maschera è tagliata. A
questo riguardo, la mascheratura può
anche essere usata come un'alternativa
ai tracciati di fissaggio che sono stati
presentati nella parte precedente di
questo tutorial. Disegnate la vostra
maschera interamente in bianco - o tutta
in gradazioni di bianco e nero- e tutte le
parti dell'oggettomascherato che
stanno all'esterno della maschera, o le
quali siano colorate di nero, verranno
tagliate. Di solito raccomando di
preferenza di usare un tracciato di
fissaggio rispetto a una maschera se
volete semplicemente un bordo dal
taglio nettoma, come vedremo dopo in
questo articolo, vi sono delle volte

quando è più facile usare una maschera.

Potete ricordare che il riempimento
e il contorno di un tracciato di fissaggio
sono irrilevanti per l'effetto finale
sull'oggetto ritagliato. Con lemaschere,
comunque, è vero l'opposto: il colore di
ciascun pixel individuale viene tenuto da
conto quando si calcola il suo effetto
sull'oggettomascherato, così il
riempimento e contorno hanno
significato.

Ho detto pixel? in un formato
vettoriale? In pratica, vi sono pochi casi
quando un file SVG viene davvero usato
come formato puramente vettoriale. Se
volete visualizzare un file SVG su uno
schermo di computero stamparlo in una
stampante lasero a getto d'inchiostro,
alla fine esso viene convertito in pixel. La
mascheratura accade durante questo
passo della produzione finale, così,
sebbene la maschera possa essere fatta
di oggetti vettoriali e l'oggetto che è
mascherato sia anche un vettore, il
risultato finale è in realtà generato
soltanto al punto che quei vettori
vengono convertiti in pixel individuali
per la visualizzazione o la stampa.

Usando un rettangolo dal contorno
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spesso e pixel strettamente neri o
bianchi, è facile vedere la differenza tra
un tracciato di fissaggio e l'uso di una
maschera per simulare il ritaglio. Nella
coppia di immagini in cima, ho usato il
rettangolo come un tracciato di
fissaggio e potete vedere che il risultato
è allineato con la linea centrale del
contorno. La seconda e la terza coppia di
immagini mostrano il rettangolo che
viene usato come una maschera, con
soltanto le parti bianche che rimangono

e le parti nere che diventano trasparenti.
È chiaro, specialmente nell'ultima
coppia, che il contorno ha un effetto.

Per adesso dovrebbe essere chiaro
che taglio e mascheratura sono
operazioni similari, così non è davvero
sorprendente che Inkscape le esponga
entrambe con la stessa interfaccia
utente. Proprio come col ritaglio,
l'oggetto chemaschera deve essere
sopra all'oggetto che deve essere
mascherato, in termini di z-index. Dopo
selezionate entrambe gli oggetti e
scegliete 'SetMask' dalmenù
contestuale o 'Object>Mask>Set' dal
menù principale. Rilasciare un oggetto
mascherato è tanto semplice come
selezionarlo (sarà descritto come
"Masked" nella barra di stato) poi
scegliere 'ReleaseMask' dalmenù
contestuale o 'Object>Mask>Release'
dalmenù principale. Proprio come con i
tracciati di fissaggio, è possibile
modificare le maschere usando lo
strumento nodi senza prima rilasciarle
ma, in generale, vi è poco beneficio nel
far così dato che potetemodificare solo
la forma della sagoma, non il suo colore.

Come avete visto, usare un
gradiente a scala di grigi come una
maschera vi da del controllo sull'opacità
dell'oggettomascherato. Potete anche
ricordare che Inkscape offre una
selezione di motivi bianchi e neri nella

finestra di dialogo 'Fill &Stroke'
(Riempimento e Contorno), più alcuni
motivi di riempimento bitmap in scala di

grigi. Questi in precedenza possono
esservi sembrati piuttosto limitanti ma la
loro natura monocromatica li rende
perfetti per l'uso come una maschera.

Ilmotivo a scacchiera è un buon
esempio di una situazione dove è più
facile usare una maschera che un
tracciato di fissaggio. Questo stesso
effetto potrebbe essere raggiunto
ritagliando con un tracciato complesso
ma, probabilmente, non vale lo sforzo

extra. Osservando attentamente la
scacchiera vi accorgerete che il
riempimento non è fatto di quadrati neri
e bianchi ma, piuttosto, di quadrati
bianchi e trasparenti. Usare bianco e
trasparente a volte può rendere più
facile vedere quale parte di un oggetto
statemascherando: le aree bianche
rimarranno visibili e le aree trasparenti
saranno tagliate. Un'area bianca
traslucida avrà lo stesso effetto di una
gradazione di grigio. Può sembrare
controintuitivo coprire le parti
dell'oggetto che voletemantenere ed
esporre le parti che saranno nascoste
ma questo è ilmodo in cui la
mascheratura è stata definita nelle
specifiche SVG, così questo è ilmodo in
cui funziona dentro Inkscape.

Poichè i tracciati di fissaggio sono
definiti permezzo di una linea di
demarcazione e un concetto di ciò che è
dentro e fuori quella linea, è possibile
usare solo un singolo tracciato o
oggetto perdefinire una forma di
ritaglio. Lemaschere, d'altra parte, sono
interessate soltanto dal colore dei pixel
così non importa veramente se la vostra
maschera è fatta da un oggetto singolo
o da una intera vagonata di oggetti
all'interno di un gruppo. Ciò vi permette
di creare disposizioni di colore
complesse emotivi che sarebbe
impossibile riprodurre usando un
tracciato singolo.
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Questo esempio utilizza come
maschera un gruppo fatto da alcuni
oggetti casuali. Potete vedere che il
gradiente radiale ripetuto del
rettangolo, fatto di una transizione
bianco-trasparente, risulta in un motivo
simile che è reso visibile dal cerchio
rossomascherato. Ma aggiungendo
caratteristiche extra nere e bianche al
gruppomaschera, potrete "passare
sopra" almotivo con sezioni esplicite di
trasparenza e opacità. Una cosa da
notare è il posto dove la linea nera
attraversa quella bianca: poiché la linea
nera è sopra, i pixel in quella posizione
sono neri, così che quella parte
dell'oggettomascherato è trasparente.
Non importa che succede all'interno del
gruppo, tutto quello che importa è il
colore dei pixel finali. Questo potrebbe
non essere ilmigliorpezzo di arte
astratta almondoma sarebbe stato

molto più difficile disegnarlo senza usare
maschere.

Sebbene possiate usare delle
maschere per creare disposizioni
complesse di ritaglio e trasparenza,
probabilmente l'uso più comunne è
semplicemenete aggiungere una
"sfumatura" ai bordi di un gruppo così
che sfumi nello sfondo. In questo caso
tutto quello che vi serve per il disegno
della maschera è una ellisse bianca
fortemente sfumata, come dimostrato
nel disegno di questa cartolina
totalmente fuori stagione.

Per tutto questo articolomi sono
riferito alle maschere come immagini in
scala di grigio. Ciò non è strettamente
vero - una maschera può essere una
qualunque combinazione di colori che
desideriate. Comunque, qualunque altra

cosa che il bianco, nero o grigio sarà
convertito in un'immagine in scala di
grigio prima di essere usata come
maschera. Ciò può rendere difficile
predirre l'effetto esatto di un colore
sulla risultante opacità così, in quasi tutti
i casi, vi raccomando di usare una pura
scala di grigio quando disegnate le
vostremaschere.

http://www.peppertop.com/

